# Table of Contents

**Introduction**

- **About FabFilter Timeless 2** .................................................. 3
- **Quick start** .................................................................................. 4

**Using FabFilter Timeless 2**

- **Overview** .................................................................................... 5
- **What-you-use-is-what-you-see** ....................................................... 7
- **Knobs** .......................................................................................... 9
- **Delay lines** .................................................................................. 10
- **Filters** .......................................................................................... 12
- **Filter parameters** ......................................................................... 14
- **Interactive filter display** ................................................................. 16
- **Modulation** .................................................................................. 17
- **Drag-and-drop modulation slots** .................................................... 18
- **XLFO** .......................................................................................... 20
- **Envelope generator** ...................................................................... 22
- **Envelope follower** ........................................................................ 23
- **MIDI source** ................................................................................ 24
- **XY controller** ............................................................................... 25
- **Input/output controls** ................................................................... 26
- **MIDI learn** .................................................................................. 27
- **Undo, redo, A/B switch** ................................................................. 29

**Presets**

- **Loading presets** ......................................................................... 30
- **Saving presets** ............................................................................ 31
- **Section presets** ........................................................................... 32
- **How presets are stored** ................................................................. 33

**Purchasing FabFilter Timeless**

- **Purchasing FabFilter Timeless** ..................................................... 34
- **Entering your license key** ............................................................... 35

**Support**

- **Support** ..................................................................................... 36
- **Upgrading to Timeless 2** ............................................................... 37
- **Manual installation** ..................................................................... 38
- **VST plug-in versions** ................................................................... 39
- **External side chaining** ................................................................. 40
- **Component routing** .................................................................... 42
- **License agreement** ....................................................................... 43
- **Acknowledgements** ..................................................................... 45
- **About FabFilter** ........................................................................... 46
About FabFilter Timeless 2

Welcome to the wobbly world of one of the most versatile delay plug-ins: Fabfilter Timeless 2. At its heart there are two independent, programmable delay lines. The addition of a high quality filter section and incredible new modulation features will get you time-warped where no man has gone before.

All these controls provide an almost unbelievable array of sound manipulation possibilities, ranging from simple repeat echo to genuinely original sounds that you wouldn’t expect from a delay plug-in.

What's new in Timeless 2?

First of all, FabFilter Timeless 2 contains a vastly improved modulation section, with all the XLFOs (programmable LFOs), envelope generators, envelope followers, XY controllers, and MIDI sources you will ever need! Modulation is more powerful and easier to work with thanks to the new what-you-use-is-what-you-see interface. Finally, the new Mid/Side mode, even lower minimum delay time, and the new Freeze feature ensure that Timeless 2 will let you go even further in regardless which creative sound-mangling experiment you are engaged in.

Of course, FabFilter Timeless 2 opens all presets from Timeless 1 without problems. See Upgrading to Timeless 2 for more information.

FabFilter Timeless 2 is available in VST, VST3, AU (Audio Units), AAX Native and AudioSuite formats.

<table>
<thead>
<tr>
<th>Windows requirements</th>
<th>macOS requirements</th>
</tr>
</thead>
<tbody>
<tr>
<td>32-bit: Windows 10, 8, 7, Vista or XP</td>
<td>OS X 10.8 or higher (64-bit only)</td>
</tr>
<tr>
<td>64-bit: Windows 10, 8, 7 or Vista (x64)</td>
<td>AU or VST 2/3 host or Pro Tools</td>
</tr>
<tr>
<td>VST 2/3 host or Pro Tools</td>
<td>Intel processor</td>
</tr>
</tbody>
</table>

Next: Quick start

See Also
Using FabFilter Timeless 2
Quick start

The installer will copy the FabFilter Timeless 2 plug-in into the common VST, VST 3, AU (macOS only) and Pro Tools plug-in folders on your computer. On macOS, the global plug-in folders in /Library/Audio/Plug-Ins are used.

In most cases, your host will then recognize the plugin automatically. However, if the instructions below do not work, see Manual installation instead.

- **Pro Tools**
  Choose an empty insert slot on one of your audio tracks, instrument tracks or buses and select FabFilter Timeless 2 from the pop-up menu in the Delay section.

- **Studio One**
  Click the '+' button next to the Inserts tab of an audio track, instrument track or bus and select 'FabFilter Timeless 2' from the drop-down menu.

- **Logic Pro**
  Choose an empty insert slot on one of your audio tracks, instrument tracks or buses and select FabFilter Timeless 2 from the pop-up menu. You will find FabFilter Timeless 2 in the Audio Units > FabFilter section (named FF Timeless 2).

- **Ableton Live**
  In Session view, select the track you would like to place FabFilter Timeless 2 on, for example by clicking the track name. At the left top of Ableton Live's interface, click on the Plug-in Device Browser icon (third icon from the top). From the plug-ins list, double-click FabFilter/FabFilter Timeless 2, or drag it onto the track.

- **Cubase**
  Choose an empty insert slot, for example in the Mixer, and select FabFilter Timeless 2 from the menu that appears. To use the MIDI features in Timeless 2, create a new MIDI track and set its output to the Timeless 2 instance you have just created. (The VST 3 version of Timeless 2 can be found in the Delay section.)

Use the Presets button at the top of the plug-in interface to try different settings from the many factory presets that are bundled with FabFilter Timeless 2. Have fun!

Next: FabFilter Timeless 2 overview

See Also

VST plug-in versions
Upgrading to Timeless 2
Loading presets
**Overview**

FabFilter Timeless 2’s interface is divided into multiple sections:

- **Presets, undo, A/B, help**
  The Undo, Redo, A/B and Copy buttons at the top of the plug-in interface enable you to undo your changes and switch between different states of the plug-in. With the preset buttons, you can easily browse through the vast library of factory presets or save your own settings so you can re-use them in other songs. The Help button provides access to the help file and other information and options.

- **Feedback and delays**
  This is where the magic begins. The delay time is controlled by a big knob and can be synchronized to the host tempo. Both delay lines have their own feedback and cross feedback knobs which determine the amount of repeats. See **Delay lines**.

- **Filter section**
  And in the filter section, the magic goes on! Our state-of-the-art multimode filters let you morph the delayed sounds, adding filtering effects ranging from gentle sweeps up to self-oscillating madness. See **Filters**.

- **Dry/wet level**
  Here you control the audio output gain. The dry (unprocessed) signal and the output of the delay lines have their own output volume knobs. (The input gain control is located at the far left of the plug-in.) See **Input/Output stage**.

- **Modulation button**
  The modulation button shows or hides the entire modulation section at the bottom of the interface. FabFilter Timeless 2 offers virtually unlimited modulation possibilities, but all this power might be a bit intimidating. That's why the modulation section is hidden by default, and you can look 'under the hood' when you want to tweak a preset or design your own.

- **Source selection bar**
  The source selection bar shows all modulation sources at a glance and lets you easily scroll around and create new sources. FabFilter Timeless 2 offers XLFO, Envelope Generator (EG), Envelope Follower (EF), MIDI and XY Controller sources. See also **Modulation**.

- **Modulation slots and sources**
  The bottom section contains the modulation sources. The modulation section in Timeless 2 is fully...
modular — but without the cables! We found a simple way to show you everything that is modulating, and what is modulated by what. Above each modulation source, the modulation slots show exactly what targets are modulated by this source and let you adjust the amount of modulation. You can very easily set up modulation connections with drag-and-drop. All in all, we think we made sound design easier and more fun!

- **MIDI Learn, channel mode, output options**
  The bottom bar contains the MIDI Learn feature which sets up any MIDI controller to control any plug-in parameter. Next, we find the channel mode option for Mid/Side channel mode, the auto-mute self-oscillation option, and a monitoring option that lets you listen to the dry input and side-chain signals.

- **Resize**
  The resize button in the lower-right corner lets you choose between normal and wide interface layouts. The wide layout eliminates scrolling in the top part of the interface and provides more space for the modulation sources at the bottom of the interface. Most hosts support dynamic resizing of the interface; otherwise just close and re-open the interface window.

---

**Next:** What-you-use-is-what-you-see

**See Also**
 Component routing
 Quick start
**What-you-use-is-what-you-see**

Often an impressive feature list results in an impressively difficult-to-use interface full of controls for parameters you might never even use. For almost every plug-in developer one of the greatest challenges when making a complex full-featured plug-in is to design an interface that is easy to use. And we think we did it! FabFilter introduces a revolutionary new interface concept: What-you-use-is-what-you-see.

The idea is simple yet powerful. At all times, the interface only contains the modulation sources and slots that you are actually using. This results in an intuitive user interface that experienced producers and novices alike will embrace.

You can easily create more modulation sources. Do you want another XLFO? Just add one! Do you want an envelope generator? Just add one and start modulating things! Of course there is a limit to the number of sources you can create, but in practice it feels like you can create as many sources as you will ever need.

To give you an idea, a simple preset without modulation looks like this:

![Simple Preset](image1)

... while a more complex preset, with various modulation sources and an expanded filter section, looks like this:

![Complex Preset](image2)
To help you understand even the most complex presets, modulation slots are grouped with each source. Each component, knob or controller that is being modulated is marked with a little M button. Simply click the M to highlight the modulation source and slots responsible for the modulation. See also Modulation.

Another interface innovation are the filter buttons in the filter section. You can control the main filter parameters simply by dragging on the filter buttons, which makes for an uncluttered interface that is easy to overview.

Next: Knobs

See Also
Modulation
Overview
Knobs

It is easy to control FabFilter Timeless 2's parameters with the large round knobs. They will light up when you move the mouse cursor around to indicate that you can adjust them. The moment you move the mouse cursor over a knob, a parameter value display will pop up, which shows the name and the current value of the parameter.

All knobs support four ways of control:

1. **Vertical mode**
   Click on the center area of a knob and drag up or down to rotate it. The knob reacts to the speed with which you are dragging, so if you move the mouse slowly, you make precise adjustments.

2. **Rotate mode**
   Grab the arrow of the knob and drag it around. By moving the mouse cursor further away from the knob while dragging it, you can make precise adjustments.

3. **Mouse wheel mode**
   Perhaps the easiest way to make adjustments is by using the mouse wheel when you hover over a knob. This mode works for all the knobs and possible panning rings. (On Windows, you might need to click in the plug-in interface first to make sure it is the active window.)

4. **Text entry mode**
   Double-click a knob to enter an exact value using the keyboard.

**Tips**

- To **reset** a knob to its default position, hold down the Ctrl key (Windows) or Command key (macOS) and click the knob once. Note: In Pro Tools, Timeless 2 uses the default Pro Tools keyboard shortcut for reset: Alt+click.

- To **fine-tune** a value when using vertical drag mode or the mouse wheel, hold down the Shift key while dragging or moving the mouse wheel. Note: In Pro Tools, Timeless 2 uses the default Pro Tools keyboard shortcut for fine tune: Ctrl+drag on Windows or Command+drag on macOS.

- There are several **handy shortcuts in text entry mode**. With frequency values, you can type e.g. '1k' to set the value to 1000 Hz, and also 'A4' for 440 Hz, or even strings like 'C#3+13'. With dB values, you can type e.g. '2x' to get +6 dB (the value that corresponds to two times louder). With all values, you can also type a percentage (e.g. '50%' will put a knob exactly in the middle position).

- Sometimes, knobs in our plug-in interfaces are **linked**: these be adjusted simultaneously by holding down the Alt key (Shift key in Pro Tools) while dragging on one of them. For example, an output level and input level setting of a plug-in could be adjusted simultaneously (in the opposite direction) this way.

Next: [Delay lines](#)

See Also

[Overview](#)
Delay lines

The delay lines are the center of FabFilter Timeless 2. Of course, they cause a delay in the transmission of a signal passing through. There is a wide range of effects possible with a digital delay: repeat echo, slap-back delay, chorus, vibrato, and resonant 'tunnel' echo.

There are two delay lines: one receiving input from the left channel, and the other from the right channel (except in Mid/Side mode).

You control each delay line with the following parameters:

- **Delay time**
  Well, guess what... this sets the delay time! To be more precise: the time of the delay given to a signal passing through.
  
  The delay time can be locked/synchronized to the tempo of your sequencer host. When this is activated using the curved switch the knob controls the sub-multiples of this tempo (we call this the Delay Offset instead of the Delay Time). The small dots that appear around the knob make it easier to get precise and quick access to certain fractions that are related to your sequencer tempo.
  
  When the delay time is not locked to your sequencer tempo it is possible to 'tap' the tempo of the delay by clicking on the number-display above or below the knob. The display will turn into an illuminated TAP button. The next time you click here the time between the clicks is calculated and used as delay time. Just tap it a few times to get some values you want to work with.
  
  In case you want to use the exact same delay time for both delay lines, enable the Delay Link switch between the delay lines. This makes it easier to set up both delay lines with the same settings.

- **Delay pan**
  Pans the output of each delay line to the left or right channel.

- **Feedback**
  You can vary the feedback to produce more than one repeat from a single sound. All the feedback control does is to send some of the delayed output (after passing through the filters) back to the input so it gets delayed again; the more feedback, the more repeats. There are separate knobs for the left and right filter output for both delay lines.
  
  When a signal coming out of a delay line is routed back into the other delay line this is called "cross-feedback" hence the names on the interface. Cross-feedback is used to mix different delay times and creates beautiful stereo effects.
  
  The amount of total feedback determines the number of audible repeats. Higher levels will have more repeats and above a certain level feedback will cause higher volumes at every cycle and thus create sonic mayhem! Be careful with your ears and speakers, and don't use too high feedback levels.
  
  There is a convenient lock icon that makes it possible to set up feedback settings for both delay lines.

- **Feedback invert switch**
  Very interesting effects can be achieved when inverting the phase of one of the feedback signals. The effect of this is most noticeable on effects that use a very short delay time. By inverting the phase of the signal fed back to the input, it allows different harmonics to be accentuated by the filtering process, and so gives a choice of two types of tonal coloration, one usually sounding thinner than the other. On longer delay times it might alter the stereo perception of the sound.
**Delay style**

There are two different ways the digital delay can behave:

1. *Tape* which behaves like a classic tape delay. When the delay time is changed in positive direction i.e. the delay time gets shorter, you will hear a increase in pitch of the delayed signal. Conversely when the delay time is made longer you will hear a decrease in pitch of the delayed signal. This is the way analog delays sound and makes 'playing' the delay so much fun.

2. *Stretch* makes this plug-in simply unique. It means that no matter whether the delay time gets shorter or longer, the pitch will remain constant using granular techniques. This is NOT possible with an analog delay and we thought this to be a highly creative addition. Listen to some of the presets using this algorithm and you will hear what sonic possibilities this option has to offer.

**Freeze**

The Freeze button lets you freeze the sound that's currently in the delay lines. As soon as you activate freeze, the input to the delay line is cut off, so no new sounds will be stored. The delay lines will keep playing the current sound, which you can now filter continuously. Also, you can of course change the delay time which will also transform the sound in the buffers. This can really warp the sound and change it into something completely different! The Freeze option is not stored in presets because it really needs to be turned on and off dynamically.

The settings of all delay parameters can be stored as a section preset.

**Tips**

- By setting a delay time of between 30 and 100 ms and adding a little gentle modulation with no feedback, you get the classic chorus effect.
- At very short delay times (5 to 50 ms), increasing feedback will give a resonant cardboard tube or tunnel echo sound, the pitch of the resonance being set by the delay time. This effect is useful in creating new sounds or modifying existing ones beyond recognition; used with a synth, it can create the illusion of ring modulation or phase sync.
- Short delays of between 30 and 100 ms are used to create slap-back echo effects, which are quite effective on vocals and guitar.
- Delay times in excess of 100 ms will give you the familiar tape echo type of sound, and this is a valuable effect for warming up vocals and guitar.
- If you are interested you can read more about delay technology on Wikipedia.

Next: Filters

See Also
Component routing
Overview
Filters

FabFilter Timeless 2 comes with two high-quality filters, each with no less than eleven different sound characteristics. These multimode filters are based on our award winning filters first developed for 
FabFilter One. You can use them individually or combine filter characteristics to create your own sounds in any way imaginable. Both filters are stereo filters.

The filter buttons let you easily adjust the main filter parameters, simply by clicking and dragging on the button. As soon as you move the mouse cursor over a filter button, value displays will pop up to show the current values of the associated parameters.

- Click and then drag horizontally or vertically to change the filter frequency and peak parameters. You can change the filter panning and response curve parameters instead by holding down the Ctrl key on Windows, or the Command key on macOS.
- To view all filter parameters, click the one of the filter buttons once. This will expand the filter section to show the complete filter interface. Click the filter button again to hide the interface. While the filter section is expanded, you can scroll the top section of Timeless’ interface with the left and right scroll buttons at the far ends of the interface.
- Hold down Shift while dragging to adjust only one parameter in the direction in which you move the mouse cursor.
- Hold down Alt while dragging to adjust parameters in both filters in parallel.
- You can also adjust the component buttons with the mouse wheel. On Windows, most mouse wheels only work vertically, but you can hold down the Ctrl and Shift keys simultaneously for horizontal adjustments.
- The filter buttons have an on/off switch in the left top corner, to quickly enable or disable the filter.

We strongly suggest for you to try all these movements yourself, and you’ll find it’s a great aid in quickly setting up the filters in Timeless the way you like. The most important parameters are always available, and if you need access to all parameters, they are just a mouse click away.

Tip: You can turn off the parameter value displays for the filter buttons with the Show Component Displays option in the Help menu.

Filter routing

Above the filter buttons, the filter routing can be set. There are three different ways of configuring the filters in the audio signal path:

1. **Serial** will put both left and right channel of the delay lines first thru filter 1 and than thru filter 2.
2. **Parallel**: The output of delay line 1 into both filter 1 and 2, and the output of delay line 2 into both filter 1 and 2.

![Diagram of Parallel setup]

3. **Per channel**: delay lines and filters are working in 2 groups. Delay line 1 uses filter 1 and delay line 2 uses filter 2.

![Diagram of Per channel setup]

---

**Next**: Filter parameters

**See Also**
- Overview
- Interactive filter display
- Section presets
Filter parameters
By clicking on one of the filter buttons in the filter section, the filter section expands to show all filter parameters and the interactive filter display.

You control each filter in Timeless 2 with the following parameters:

- **Frequency**
  The filter frequency is adjustable over the entire audio range. The Frequency controls the center or cut-off frequency of the active filter and can be controlled in real time, either manually or via external devices.

- **Pan**
  The Pan ring around the Frequency knob lets you filter the left and right channels differently. It works as a stereo balance setting for the center frequency of the filter. For example, when you turn the Pan knob to the left, the left channel will be filtered with a lower center frequency, and the right channel will be filtered with a higher center frequency. You can use this to create various stereo filtering effects, especially in combination with modulation.

- **Peak**
  The Peak knob adjusts the resonance of the active filter. A little resonance will cause the filter to create warmer and more characteristic tones. At maximum resonance, the filter will self-oscillator with most filter characteristics. (The Auto Mute Self-Osc option in the bottom bar will help to keep this manageable. See Input/output options.)

- **Characteristic**
  FabFilter Timeless offers the possibility to choose between three different filter characteristics:
  1. FabFilter One, the original filter characteristic taken from our award-winning FabFilter One synthesizer
  2. Smooth, like the cream in your coffee
  3. Raw, a filter with lots of overdrive and exhibits a character of its own
  4. Hard, moderately distorting filter, with a nice clean whistle
  5. Hollow, juicy moderate distortion with fairly much low-end self-oscillation
  6. Extreme, for more wild sonic ideas
  7. Gentle, a more smooth and clean general purpose characteristic
  8. Tube, with a warmer sound and nice overdrive, great for synth sounds
  9. Metal, with a rough, sharper sound and distortion
  10. Easy Going, a softer version of the Tube filter
  11. Clean, linear behavior with no clipping or distortion at all

- **Response**
  The response of each filter can be set to either *Low Pass, High Pass, or Band Pass*. In **Low Pass** mode, the filter will pass through frequencies lower than the center frequency. In **High Pass** mode, frequencies higher than the center frequency will be passed through. In **Band Pass** mode, only the frequencies around the cut-off frequency will be passed through.
• **Slope**
  The slope switch sets the steepness of the filter, which controls how aggressively the frequencies around the center frequency are filtered. You can choose between 12 dB/octave, 24 dB/octave or 48 dB/octave settings. For example, if the response is set to Low Pass, more high frequencies will remain at 12 dB/octave than at 48 dB/octave.

• **Enabled**
  The filters can each be switched on or off with the small buttons left of the characteristics dropdown menu in the filter section. While a filter is bypassed, it will look disabled, but the controls can still be used to adjust the filter.

The settings of the filter parameters can be stored as a [section preset](#).

*Next: [Interactive filter display](#)*

*See Also*
  [Overview](#)
  [Filters](#)
Interactive filter display

The interactive filter display gives an overview of the filter parameters and makes it very easy to adjust multiple filter parameters simultaneously. The vertical lines in the background represent a logarithmic scale that correspond to the actual filter frequencies.

To open the filter display, click on one of the filter buttons.

- Drag a **filter dot** to adjust the *Frequency* and *Peak* parameters for that filter.
- Drag the **link dot** between filter 1 and 2 to adjust both filters simultaneously.
- **Shift+click** a filter dot to toggle between the different filter slopes.
- **Ctrl+click** (Command+click on Mac) a filter dot to toggle between the different filter responses.
- When holding down the **Alt** key while dragging a filter dot, the other filter will change accordingly, as if you where dragging the link dot.
- Holding down both the **Alt+Ctrl** keys (**Alt+Command** keys on Mac) while dragging a filter dot will adjust the two filters while fixing the link dot in the center, so the other filter will 'mirror' the changes.

**Tips**

- Of course, all changes made in the filter display can be automated!
- You can connect a MIDI controller to either the frequency or the peak adjustment of the link dot with the **MIDI Learn** feature.

Next: **Modulation**

See Also

**Filters**

**Overview**
Modulation

The real fun with Timeless 2 starts with the incredible modulation options. Almost any parameter can be modulated. These are called **modulation targets**. They can be modulated by any of the available **modulation sources**: XY controllers, XLFOs, envelope generators, envelope followers and MIDI sources. The modulation signal always flows via a **modulation slot** that allows you to vary the extent of modulation.

Use the **Modulation button** at the top to show or hide the entire modulation section, which consists of the following elements:

- **Source selection bar**
  The source selection bar shows a schematic overview of all modulation sources at all times. Simply click on a source button here to scroll the source into view. The highlighted section of the bar shows the currently visible part, and it can be dragged to scroll the sources as well. The top segment of each source button lights up according to the modulation signal it is currently sending.

- **Modulation slots**
  As said before: every modulation source uses a modulation slot to send its signal to the target. Timeless 2 always groups all modulation slots above the source that they’re connected to. Each slot displays the destination, graphically shows the amount, and you can quickly turn it on or off, or reverse its output.

- **Modulation sources**
  The modulation sources are organized in a horizontally scrolling strip below the source selection bar. There are 5 different kinds of sources available: The **XLFO** can generate almost any waveform you can imagine and can be synchronized to the host tempo. The **Envelope generator** is of the usual ADSR kind and triggered by audio or MIDI. The **Envelope follower** will follow the loudness of the incoming audio or side-chain signal. The **MIDI source** transforms any incoming MIDI data into a modulation signal. Finally, the **XY controller** lets you modulate two targets using horizontal and vertical mouse movements.

  To add a modulation source, click the + button in the source selection bar.

  To delete a modulation source, click the remove button ✗ in the top right corner in the source interface. When a source is deleted, modulation slots that use that source will also be deleted automatically.

  **Tip:** You can scroll the modulation source section with the mouse wheel. On Windows, most mouse wheels only work vertically, but you can hold down the Ctrl and Shift keys for horizontal scrolling in that case.

Next: Drag-and-drop modulation slots

See Also
Overview
Drag-and-drop modulation slots

One of the best features of FabFilter Timeless 2 is undoubtedly the ability to set up modulation connections with drag-and-drop. There is no need to search through long drop-down menus containing dozens of sources and targets or to find your way in cluttered and obscure matrix views. This simple method of making modulation connections makes sound designing become fun, easy and, above all: fast. So how does it work?

Grab a source... ... drag it to a target... ... and drop it.

First, grab the source drag button that you would like to use as a modulation signal, for example XLFO 1. The moment you click on the source drag button, the interface dims and all modulation targets are highlighted.

The moment you start dragging, you will see a line from the source drag button to the icon that you are dragging. If you hover the mouse over filter buttons or source selection buttons they will automatically be activated. The mouse cursor will snap to any available modulation target.

Now drop the icon on the highlighted knob of the parameter that you would like to modulate, for example the Delay 2 Time knob. That’s all there is to it!

If you wish, you can also add a slot manually using the small plus button above each modulation source. You can also modulate slot level knobs, which makes incredibly complex modulation setups possible. To sort the slots click the + button in the source selection bar and select Sort Slots from the menu that pops up.

Once a slot has been added, you can edit it:

- Use the Level slider to adjust the amount of modulation. Like with knobs, hold down Shift for fine-tuning; hold down Alt to adjust all slot levels for the same source; Ctrl-click (Windows) or Command-click (macOS) to reset the level to the default value.
- To the left of the Level slider, you can invert the modulation signal with the +/- button.
- When you hover over the slider on the left an on/off button appears. Use this to temporarily disable the slot. On the right a menu is accessible that gives direct access to all available modulation targets.
- To delete the slot, click the Remove button to the right of the Level slider.

Our what-you-use-is-what-you-see interface makes complex programming very easy. Timeless 2 uses dynamic slot highlighting to visualize all the sources that modulate a specific target. When a parameter is modulated a small modulation indicator “M” appears:

Click the M modulator indicator to highlight all slots that modulate this target. In the source selection bar the sources that modulate the target are also highlighted.

This feature makes programming so much more fun because it’s easy to see what is happening inside a patch. To return to the normal interface click anywhere on the interface background or click the Modulation Indicator again.

When a modulation indicator appears next to a filter button or envelope generator, this means one or more parameters are modulated. When you click that indicator it will highlight all slots that modulate a target of the component or envelope generator.

Next: XLFO

See Also
Modulation
What-you-use-is-what-you-see
The XLFO is like a classic LFO but it can do so much more! It can also be used as a 16 step sequencer with an individual glide parameter for every step. The display shows the waveform that is used by the XLFO. Steps can be freely added or deleted to shape the funkiest of waveforms. But there is more... This XLFO can also be used as arpeggiator! The values can be equally be distributed over 2 octaves, so when connecting it to any pitch parameter, it will function like an arpeggiator. We couldn't make it more funky!

To add an XLFO as a modulation source, click the + button in the source selection bar and click New XLFO.

At the left of the XLFO interface, you find the global parameters that affect the entire waveform:

- **Frequency**
  The frequency knob sets the time it takes for 1 cycle of the waveform to complete. This knob is a modulation target, so you could let one XLFO modulate the frequency of another XLFO. The XLFO can be synchronized to the tempo of the plug-in host or set to run free. With the options at the top-right corner of the frequency button you can choose the different settings:
  - Free running mode will allow values from 0.0 to 500 Hz, so the minimum cycle length is 0.002 seconds.
  - When using any of the synchronized cycle lengths (16 to 1/64, measured in bars) the frequency knob changes into the Offset knob. It now acts like a cycle length multiplier and therefore is capable of changing the cycle length relative to the host tempo, from half to two times the host tempo. Click the dots around the knob to jump to certain predefined offsets for dotted and triplet synchronization. Note: the Offset parameter is not a modulation target, but you can modulate the Phase offset instead.

- **Balance**
  The outer ring of the frequency knob adjusts the time balance of the first and last halves of the step sequence. For example, when turned to the left, the first half of the waveform is generated more quickly than the last half.

- **MIDI sync**
  The XLFO can be restarted at any point using MIDI if the MIDI sync option is enabled at the top-right corner of the frequency knob. When activated a note-on MIDI message (e.g. pressing a key) will restart the cycle of the waveform (to the point set by the Phase offset slider).

- **Snap**
  This function makes it possible to use the XLFO as an arpeggiator. When you enable Snap, a small piano keyboard appears, the range of the XLFO turns into 2 octaves, and steps "snap" to notes on the piano keyboard. Now when you modulate the filter frequency, turn the slot level to maximum, and the total amount of modulation will exactly correspond to 2 octaves. With filter frequency parameters, you will hear individual notes if used with high filter peak settings.

- **Glide**
  The global Glide knob acts like an overall glide offset. The amount of glide determines the point within a step at which the XLFO starts to interpolate to the value of the next step. The global Glide value is added to the glide value for individual steps to arrive at the final glide value for each step. The final glide value is limited between 0 (no interpolation) and 1 (full interpolation). Because the global Glide value can range from -1 to 1 it can completely overrule the individual step glide values at the extreme settings. It is also a modulation target which allows for very cool effects.

- **Phase offset**
  In the step editor you can see a triangular shape. The vertical line of the shape indicates the beginning of each cycle. You can move this triangular shape, and thus change the beginning of a XLFO cycle. This phase offset is a modulation target, so when the XLFO frequency is set to 0, you can use another modulator to cycle through the different steps.
  **Tip:** Like with knobs, you can Ctrl/Command-click on the phase offset slider to reset it.

At the top right of the global settings, the Presets button provides access to the XLFO section presets. The Remove button deletes the XLFO source. By default, the XLFO starts with two steps that make a sine wave. You can customize this by overwriting the predefined Default section preset.
Editing Steps

You can shape the waveform of the XLFO in almost any way you want by editing the individual steps.

- Drag a step up or down to **change the value** for the step.
- Click a step to **select** it.
- Hold down Ctrl (Command on Mac) and click a step to **select multiple steps**. Hold down Shift and click a step to **select a consecutive range of steps**.
- Click next to a step to **deselect** all steps.
- Click the + button at the end of all steps to **add** a new step. The new step is added to the right of the selected step, or at the end of all steps.
- Click the - button at the end of all steps to **remove** the selected steps. If no steps are selected, the last step is removed.

If one or more steps are selected, the XLFO expands to show the **step interface** where the parameters for the selected steps can be edited:

- **Random**
  The Random button enables random values for this step. If enabled, the XLFO will use a new random value for the step each time it encounters it. The display also changes to show that the value is chosen at random (see step 3 in the screen shot above).

- **Value**
  The Value knob adjusts the value of step. This is the same as dragging the step up and down, except that with multiple selected steps, the value of all steps is set to the same value. In contrast, when you drag multiple selected steps, the relative distance is kept the same.

- **Curve**
  The Curve button selects the curve that is used to interpolate to the next step when the final glide value is higher than 0: Linear, Sqr, Sqrt and Sine.

- **Glide**
  The Glide knob sets the per-step glide value. This is combined with the global glide value to determine at which point the XLFO starts to interpolate towards the next step.

To start exploring the many sound shaping possibilities start with a XLFO that **modulates** a Delay Time or Filter Frequency knob to make the sound change over time. You'll be amazed by the many possibilities. Have a look at the presets to see the XLFO in many different setups to get an idea of what it can do for you and start creating your own sequences to funkify your life!

Next: Envelope generator

See Also
- Modulation
- Drag-and-drop modulation slots
- What-you-use-is-what-you-see
Envelope generator

The envelope generator (EG) generates an ADSR envelope. The envelope being the way in which the level changes with time and is controlled by the Attack, Decay, Sustain and Release parameters. Its function is to modulate a parameter over time, based on MIDI input or the amplitude of the input signal or side chain signal.

To add an envelope generator as a modulation source, click the + button in the source selection bar and click New Envelope Generator.

The following EG parameters are available (hold the mouse over a control point in the EG display to see which parameter it affects):

- **Trigger**
  
  The EG can be triggered by three different kinds of input: MIDI note events, the main input signal, or the signal from the side-chain input. When MIDI is selected, the Threshold knob is hidden. Depending on the type and amplitude of the incoming signal you need to adjust the threshold for optimal functioning. Look at the top segment of the source button for the EG to see when it is in the triggered (Attack-Decay-Sustain) state. See also VST plug-in versions.

- **Delay**
  
  The time it takes for the attack to start after the key is pressed (or triggered when the side-chain signal exceeds the threshold).

- **Attack**
  
  The Attack portion of the envelope is the time taken for the amplitude to reach maximum value. Slow attack is commonly part of sounds called pads. But for percussive sounds the attack time should be as short as possible.

- **Decay**
  
  After the sound has reached its maximum level, it starts to decay until it reaches a level known as the Sustain level at a rate set by the Decay time setting.

- **Sustain**
  
  This is the level reached after the decay time. The EG will hold this level as long as a key is pressed. Note that this parameter specifies a volume level rather than a time period.

- **Hold**
  
  Once the key is released, the value will remain at the sustain level for a time set by the hold parameter.

- **Release**
  
  After the hold time the sound resumes its decay, this time at a new rate determined by the Release setting.

**Tips**

- When adjusting the EG control points, you can hold down the Shift key to fine-tune a setting, just like with regular knobs.

- To let a sustain pedal control the EG, you can hook it up to the Hold setting. The recommended way to do this is via a MIDI source.

At the top right of the EG interface, the Presets button ‡ provides access to the EG section presets. The Remove button X deletes the envelope generator. You can customize the default EG settings (used when creating a new EG) by overwriting the predefined Default section preset.

Next: Envelope follower

See Also

Modulation

Drag-and-drop modulation slots

What-you-use-is-what-you-see
**Envelope follower**

The envelope follower modulation source will output an envelope similar to the side-chain signal. The amplitude of the positive peaks of the input signal is measured and the outer shape (= envelope) is the output signal of the modulation source. You can set the **Attack** and **Release** parameters to 'smooth out the bumps'.

To add an envelope follower as a modulation source, click the + button in the **source selection bar** and click **New Envelope Follower**.

The two buttons at the top of the EF source interface select which signal is used to trigger on: the main input signal or the signal from the side-chain input. See also [VST plug-in versions](#).

At the top right of the source interface, the Presets button ☰ provides access to the EF **section presets**. The Remove button ☒ deletes the envelope follower. You can customize the default EF settings (used when creating a new EF) by overwriting the predefined **Default** section preset.

---

*Next:* [MIDI source](#)

**See Also**

- [Modulation](#)
- [Drag-and-drop modulation slots](#)
- [What-you-use-is-what-you-see](#)
MIDI source

The MIDI source is a powerful modulation source if you want more control over Timeless 2 using a MIDI keyboard or MIDI control knobs. Note that you first need to route data from a MIDI track to Timeless in your host.

To add a MIDI source as a modulation source, click the + button in the source selection bar and click New MIDI Source.

- **MIDI Input**
  Normally the MIDI source lets you use MIDI input such as velocity, pitch bend and modulation wheel to influence any parameter that can be modulated.

- **Controller number**
  ... but when you set the input selection to Controller, it lets you use any MIDI controller as a modulation source.

- **Response curve**
  The response curve can be adjusted to get the desired control over the MIDI source output. For example, when used with velocity as MIDI source the linear, exponential, logarithmic, square, square root or sine curves make great dynamic differences.

Using a MIDI source is different from MIDI Learn because there is no direct control of a knob via MIDI but it uses a modulation slot instead. This way you can add modulation to an already modulated destination. Or you can use the full rotation of a knob while actually modulating a smaller range. This can be a good way to control say, the filter cut-off frequency or EG attack for which you sometimes want to make small changes with great precision.

At the top right of the source interface, the Presets button provides access to the MIDI source section presets. The Remove button deletes the MIDI source. You can customize the default MIDI source settings (used when creating a new MIDI source) by overwriting the predefined Default section preset.

**Tips**

- When modulating filter frequency with pitch bend, the default slot level value corresponds to +/- one note of modulation (you can reset to the default value by Ctrl/Command-clicking the slot level). The maximum slot level corresponds to +/- one octave.

- To let a sustain pedal control an envelope generator, use a MIDI source. Set the input to Controller, and the controller number to 64. Now, drag the source drag button for the MIDI source to the hold control point of the envelope generator, and set the slot level to maximum. Of course, you can also set up more sophisticated behavior of the sustain pedal, for example by modulation the release setting instead of hold: the possibilities are endless.

- The VST 3 version of FabFilter Timeless 2 doesn’t support per-note aftertouch modulation.

Next: XY Controller

See Also
- Modulation
- Drag-and-drop modulation slots
- What-you-use-is-what-you-see
- MIDI learn
**XY Controller**

The XY Controller makes for more tweaking fun. It's a classic, and we didn't dare to leave it out! It can control two parameters with one mouse movement. When browsing presets don't forget to listen to the sound mangling possibilities provided by these controllers.

To add an XY controller as a modulation source, click the + button in the source selection bar and click **New XY Controller**.

![XY Controller](image)

Because the XY controller has two "outputs", it also has two source drag buttons labeled X and Y. The slots for the XY controller are grouped in two rows, with the X-slots at the top. For example, in the screenshot above, the X axis controls the output panning, while the Y axis controls the level.

The Remove button \(\text{X}\) deletes the XY Controller.

**Tips**

- To reset the XY Controller to its default position, hold down the \(\text{Ctrl}\) key (Windows) or \(\text{Command}\) key (macOS) and click once.
- When you want to adjust only one parameter on one axis, holding \(\text{Shift}\) will make it easier to do so while keeping the other parameter constant.
- With **MIDI learn**, you can set up a hardware MIDI controller to control the XY controller. So if your MIDI controller has XY-functionality you can directly control Timeless 2.

*Next: Input/output controls*

**See Also**

Support
**Input/output options**

FabFilter Timeless 2 provides a rich variety of input and output options. In the main section interface, you will find basic volume controls:

- **Input Level**
  Located on the left of the main interface section is the main input volume control. This will set up the amount of signal going into the delay lines. Remember that overdriving the filter gives an more harmonically rich sound so feel free to experiment with higher levels.

- **Dry/Wet Level**
  On the right of the main interface section, the Dry Level and Wet Level knobs control the amount of dry (unprocessed) signal and the amount of delayed and filtered signal that is coming out of the plug-in. Panning settings are also included.

- **Dry Enabled**
  Located above the Dry Level knob, the Dry Enabled button is an easy way to stop dry signal coming through. Since a delay is often used as a send effect (inserted on a bus) you wouldn't want dry signal coming through in that case. This is a valuable feature when you are browsing presets which were not specifically designed for this kind of usage. The Dry Enabled setting cannot be saved in a preset and therefore will not be altered when browsing presets. However, you can save the current setting as the start-up default by clicking **Options > Save As Default** in the presets menu (useful for example if you always happen to use Timeless 2 as a send effect).

In the bar at the bottom of the plug-in, there are additional options:

- **Channel Mode**
  The Channel Mode option lets you choose between **Left/Right** and **Mid/Side** operation of Timeless 2. In Mid/Side mode, the incoming stereo signal is converted into Mid (mono) and Side parts, which are then routed to the separate delay lines. This enables you to delay the stereo part differently than the mono part of the signal, ensuring interesting and totally original stereo effects! At the end of the plug-in, after the Dry/Wet Level knobs, the signals are converted back to a normal stereo signal.
  Note that Mid/Side mode also allows you to easily adjust the balance between Mid and Side using the panning rings around the Dry Level and Wet Level knobs.

- **Auto Mute Self-Oscillation**
  The Auto Mute Self-Osc option reduces the resonance of the filters if there is no incoming audio signal. Depending on the filter characteristic you can push the filters into self-oscillation with increasing peak values. The auto-mute feature will make higher peak settings possible while the filters will not be howling continuously when you stop playback in your host.

- **Audition**
  The audition switch (recognizable by its headphones icon) lets you listen to either the normal output signal (default setting), the input signal (bypassing the entire plug-in) or the side chain signal. When setting up side chaining in your host this is very useful to confirm that the correct side chain signal is routed to the plug-in.

---

Next: [MIDI learn](#)

See Also

- [Component routing](#)
- [Overview](#)
MIDI Learn

Controlling FabFilter Timeless 2's parameters directly with MIDI is very easy using the MIDI Learn feature. With MIDI Learn, you can associate any MIDI controller with any parameter.

Click the MIDI Learn button in the bottom bar to enter MIDI Learn mode. The interface dims and the parameters that can be controlled are highlighted. Each parameter has a small text balloon that displays the associated controller number. Now do the following to associate a controller number with a parameter:

1. Touch the control of the desired parameter in the interface that you wish to control. A red square will mark the chosen parameter.
2. Adjust the slider or knob on your MIDI keyboard or MIDI controller that you want to associate with that parameter.

That's it! The parameter will now be controlled with the MIDI controller. You can now go back to step 1 to associate a different parameter. Note that there is no warning when you associate a different knob with a controller number that is already used. It will just be replaced.

To exit MIDI Learn mode, click the MIDI Learn button again, or click Close at the top of the interface.

Click the small menu drop-down button next to the MIDI Learn button to access the MIDI Learn menu:

- **Enable MIDI**
  This globally turns MIDI control of parameters on or off: useful in hosts that automatically send all MIDI events on a track to all effect plug-ins associated with that track as well.
- **Clear**
  This submenu shows all parameter associations and lets you delete individual associations or clear all associations in one step.
- **Revert**
  Reverts to the last saved MIDI mapping (or the state when the plug-in was started).
- **Save**
  Saves the current MIDI mapping so Revert will go back to this state. The current mapping is automatically saved when closing the plug-in.

Routing MIDI to effect plug-ins

For MIDI Learn to work properly, the plug-in need to actually receive MIDI of course. Depending on your host, it can be quite difficult to route MIDI data to effect plug-ins. Here's how to do it in the most important hosts:

- **Pro Tools**
  Create a new MIDI track. From the MIDI input drop down menu, choose your MIDI device (if not already selected) and from the MIDI output drop down menu, choose FabFilter Timeless 2 ->
channel 1 for the instance you would like to control.

- **Logic Pro**
  Instead of adding FabFilter Timeless 2 to one of the insert slots, create a new **Instrument Track**, and click on the Instrument slot. Then choose **AU MIDI-controlled Effects > FabFilter > FF Timeless 2**. Now, the plug-in receives MIDI. To get audio into the plug-in, click the 'Side Chain' drop down menu in Logic’s plug-in header and choose the actual input track. Next, you can mute that original track, so you only hear the audio through the plug-in. The only downside is that plug-ins with an external side-chain cannot use it anymore.

- **Ableton Live**
  First of all, create a new **MIDI track**. From the 'MIDI from' drop down menu, choose your MIDI device (if not already selected). Then, in the 'MIDI to' drop down menu, choose the Audio track that has FabFilter Timeless 2 on it. Note: only the first plug-in on any track can receive MIDI.

- **Cubase**
  Simply create a new **MIDI track** and set its output to the Timeless 2 instance you would like to control via MIDI.

See Also

*Overview*
Undo, redo, A/B switch

The Undo and Redo buttons at the top of the FabFilter Timeless 2 interface enable you to easily undo changes you made to the plug-in. With the A/B feature, you can quickly switch between two different states of the plug-in.

- The **Undo** button at the left will undo the last change. Every change to the plug-in (such as dragging a knob or selecting a new preset) creates a new state in the undo history. The Undo button steps back through the history to restore the previous states of the plug-in.
- The **Redo** button cancels the last undo command. It steps forward through the history until you are back at the most recent plug-in state.
- The **A/B** button switches from A to B and back. Before switching, the current state of the plug-in is saved, so if you click this button twice, you are back at the first state. The button highlights the currently selected state (A or B). In the example above, the A state is active.
- The **Copy** button copies the active state to the inactive state. This marks the current state of the plug-in and allows you to go back to it easily with the A/B button. After clicking Copy, the button disables itself to show that both states are equal, so there is nothing to copy anymore.

**Notes**

- If the plug-in parameters are changed without using the plug-in interface, for example with MIDI or automation, no new undo states are recorded.
- The Undo and Redo buttons will disable themselves if there is nothing to undo or redo.

Next: Loading presets

See Also

Overview
Loading presets

Plenty of presets are provided with FabFilter Timeless 2, giving a good idea of what you can do. You can either use the presets as they are, or tweak them further to create your own unique sounds.

- To load a preset, click the preset button. The presets menu will appear with all available presets. Click a menu item to load that preset. The currently selected preset is highlighted with check marks.

- To explore the presets one by one, click on the little arrow buttons to the left and right of the main preset button. This will load the previous or next preset in the menu.

The preset button shows the name of the current preset. If you have changed the preset by adjusting one or more parameters, the name is dimmed to indicate that this is not the original preset anymore.

Tips

- The Default Setting preset is loaded automatically when FabFilter Timeless 2 is started. To change the default settings, simply overwrite this preset by clicking Options > Save As Default in the presets menu.

- To open a preset outside the presets folder, click Options > Open Other Preset. This might be useful if someone sends you a preset by email, for example.

- If somehow the factory presets are lost or not installed properly, click Options > Restore Factory Presets in the preset menu to restore them.

MIDI Program Change and Bank Select

Loading a presets can also be done via MIDI, using Bank Select and Program Change messages. Click Options > Enable MIDI Program Changes in the preset menu to enable or disable this feature. When enabled, the corresponding bank/program numbers are shown in front of the preset name (for example: (0/65) My Preset). This means that you can load that preset by first sending a Bank Select message to select bank 0 and then sending a Program Change message to select program 65.

Important: All the presets in your preset folder are numbered automatically, starting with bank 0 and program 0. This way, you are able to access any of the presets via MIDI. However, this also means that when you add new presets to the menu, bank/program numbers of other presets might change. Be aware of this when recording program changes in a session! We recommend to create a dedicated folder in your presets folder for your program changes, and name it with two leading underscores (e.g. "__Programs") to ensure it’s the first folder in your preset collection and the presets in this folder start with bank 0 and program 0.

Compatibility with Timeless 1

All presets created with Timeless 1 can be loaded in Timeless 2. If Timeless 1 is also installed on your computer, your Timeless 1 presets will be accessible via the V1 Preset Folder submenu in the preset menu. The factory presets for Timeless 1 are also included in the Timeless 2 factory presets, so you only need to use the V1 Preset Folder submenu to access presets you might have created yourself.

You can read more about compatibility between Timeless 1 and Timeless 2 in Upgrading to Timeless 2. Please take some time to read it if you are planning to replace Timeless 1 instances with Timeless 2 instances in your songs.

Next: Saving presets

See Also
Overview
Acknowledgements
Saving presets

You can easily extend the included presets with new settings to build your own library of presets for FabFilter Timeless 2 that you can reuse in various projects. This is also a good way to copy settings across multiple instances of FabFilter Timeless 2 in a session.

To save the current setting as a preset, click the preset button, and then click Save As. A standard Save dialog will appear. Type a name for the new preset and click Save to finish.

In the Save dialog, you can also rename and delete existing presets and create a new folder to store presets in. New folders will show up as new categories in the preset menu. (On macOS, this should be done with the Finder.)

See How presets are stored to determine the preset folder location and learn more about factory presets.

See Also
Loading presets
Overview

Next: Section presets
Section presets

To make designing sounds for FabFilter Timeless 2 easier, you can save section presets for different sections of the plug-in. In this way you can, for example, easily re-use certain settings. To load and save section presets, click the Presets button that appears in each section. This will display a presets menu for that section. FabFilter Timeless 2 comes with a selection of ready-made section presets, but we encourage you to save your own presets to build a custom library of sound building blocks.

Supported sections are:

- The delay lines.
- The filter section, including routing
- XLFO
- Envelope generator
- Envelope follower
- MIDI source

When you add a new modulation source, it loads its Default section preset. You can customize the initial settings by just overwriting that preset using the Save dialog.

Section presets are stored in the Application Data folder (Windows) or Application Support folder (macOS) for the current user. For example, the full path to the section presets on Windows 10 is C:\Users\<User>\AppData\Roaming\FabFilter\Timeless 2\Component Presets (note that this folder is hidden by default). You cannot change the section preset paths.

Next: How presets are stored
See Also
Loading presets
Overview
How presets are stored
Presets for FabFilter Timeless 2 are stored in separate files with the .ffp extension (for FabFilter Preset). All presets reside in subfolders in the main preset folder. The subfolders will show up as separate categories in the preset menu. You can also further divide the subfolders into categories.

You can manage the preset files just like other files on your computer. The easiest way to do this is in the Save dialog that appears if you are saving a preset. The preset menu will automatically reload itself with the changes when the dialog is closed.

Furthermore it is very easy to share your newly created presets with other users since FabFilter presets use the same file format on both Windows and macOS.

The default location of the main preset folder is My Documents\FabFilter\Timeless 2 for Windows, and ~Library/Audio/Presets/FabFilter/FabFilter Timeless 2 for macOS. To change this location, first copy all presets to the desired new location, and then click Options > Change Preset Folder in the preset menu and select the new folder.

Restoring factory presets
If you have accidentally lost the factory presets, you can easily restore them by clicking Options > Restore Factory Presets in the preset menu. This will install all factory presets again.
Purchasing FabFilter Timeless 2

Once you have downloaded and installed the evaluation copy of FabFilter Timeless 2, you may evaluate it during 30 days. Every time you start the plug-in, you will see the following dialog:

While there are still days left, you can click **Evaluate** to start working with the plugin. If you want to keep using FabFilter Timeless 2 after the evaluation period, you must buy a copy in the online FabFilter Shop by clicking the **Buy Now** button in the evaluation dialog.

- Go to the FabFilter Shop and purchase FabFilter Timeless 2 now [🔗]

We accept a wide range of payment methods, like credit cards, PayPal, wire transfer and iDeal. The FabFilter Shop uses secure connections and encryption: therefore your personal information is completely safe.

Within a few minutes after you have purchased your copy, you will receive an email containing your personal license key. You use this license key to turn the evaluation copy into a fully registered version without the evaluation dialog and the 30-day trial restriction. In addition, we will automatically create a FabFilter account [🔗] for you (if you don't have one already). Here, you can access all your license keys at any time.

**Note:** If the evaluation period has expired but you didn't have the chance to properly evaluate the plug-in, you can request a new evaluation period by contacting us at info@fabfilter.com.

Next: [Entering your license key](#)

See Also
- [Support](#)
- [License agreement](#)
Entering your license key

After you have purchased FabFilter Timeless 2 in the online FabFilter Shop, you will immediately receive an e-mail containing your personal license key. This license key will turn the evaluation version into a fully registered plug-in.

- Start FabFilter Timeless 2 and click Enter License in the evaluation dialog, or click Enter License on the Help menu if the plug-in is already running.
- Copy the license information from the email you have received and paste it into the text field. Make sure that you are copying the entire license key including the Product and Licensee lines! If you are not sure what text to copy, just copy and paste the whole e-mail.

![Enter License dialog](image)

After you have entered your license information, you will need to restart the plug-in host, so make sure you save your settings if needed. From now on, you will be able to use FabFilter Timeless 2 for an unlimited period of time with full support via email.

Tips

- After your purchase, you can always retrieve your license key again by logging into your personal FabFilter account. Here you can also keep track of all your orders and take advantage of great discounts when buying other FabFilter plug-ins.
- To deauthorize your license key and remove it from the computer, click Deauthorize on the Help menu. If you temporarily needed to install your license on another computer, or if you have transferred your license to someone else, this is the way to deinstall your personal license key safely.

Next: Support

See Also
Purchasing FabFilter Timeless 2
Support
License agreement
Support
If you need help with problems or questions, and the help file does not provide an answer, please visit the support pages on our web site.

- Go to FabFilter Support

From here, you have direct access to the customer support forum, very useful tutorial videos for all FabFilter plug-ins, online and PDF versions of all our help files, and a section with extra downloads (such as presets, controller templates, older plug-in versions).

For sales-related questions and technical support, you can also contact FabFilter directly at info@fabfilter.com.

Reporting a bug
If you have encountered a bug in FabFilter Timeless 2, first of all make sure that you are using the latest version of the plug-in, which you can find at www.fabfilter.com/download. You can easily check the version of FabFilter Timeless 2 that you are using by clicking Help > About in the plug-in interface. If the bug is still present in the latest version, please send us an e-mail at info@fabfilter.com and include as much technical information as possible: operation system and version, host software and version, steps to reproduce the bug, etc. Thanks in advance!

Next: Upgrading to Timeless 2

See Also
Overview
About FabFilter
Upgrading to Timeless 2

Upgrading from Timeless 1 to Timeless 2 is safe and easy: installing Timeless 2 will not replace or delete the previous Timeless 1 plug-in. Both versions will co-exist and can both be used at the same time. This ensures that you can open old songs that use Timeless 1 without problems!

Timeless 1 presets

All presets created with Timeless 1 can be loaded in Timeless 2. If you upgraded from Timeless 1 to the new version, your original Timeless 1 presets will be accessible via the V1 Preset Folder item in the preset menu. See also Loading presets.

Replacing a Timeless 1 instance by Timeless 2

If you are working on a song and want to replace a Timeless 1 instance with the new Timeless 2, we advise you to do the following:

- First, save the current setting of the Timeless 1 instance as a FabFilter preset in the Timeless 1 preset folder.
- Then, remove the Timeless 1 instance and add Timeless 2 in its place.
- Finally, load the V1 preset that you just created into Timeless 2 via the V1 Preset Folder submenu in the preset menu.

Automation

Because the feature set of Timeless 2 has changed fundamentally, any automation data that has been written by a Timeless 1 instance cannot be read correctly by Timeless 2.
Manual installation

When installing FabFilter Timeless 2, the installation program will try to copy the plug-in into the appropriate plug-ins folders, and in most cases your host will recognize FabFilter Timeless 2 automatically. Otherwise, please follow these instructions:

Windows

On Windows, most hosts have their own VST plug-ins folder. So if you are using Windows and your host does not recognize FabFilter Timeless 2, you need to locate the proper plug-ins folder for your host first (it is usually shown in the Preferences or similar dialog). Then, copy the file `FabFilter Timeless 2.dll` from `C:\Program Files\FabFilter\Timeless 2` (or `C:\Program Files (x86)\FabFilter\Timeless 2` if you are using a 32-bit host on 64-bit Windows) to the plug-ins folder that you have found and restart the host so it can reload all its plug-ins. For the AAX version of Timeless 2, copy the `FabFilter Timeless 2.aaxplugin` folder to the common Pro Tools AAX plug-in folder on your computer.

You can simply uninstall plug-ins or bundles via the Control Panel.

macOS

On macOS, plug-ins are installed in the standard plug-in folders in the system Library folder. These are the only possible correct locations:

- Audio Units: `/Library/Audio/Plug-Ins/Components`
- VST/VST3: `/Library/Audio/Plug-Ins/VST` and `/Library/Audio/Plug-Ins/VST3`
- AAX: `/Library/Application Support/Avid/Audio/Plug-Ins`

Note: AU and VST/VST3 plug-ins may also be placed in the user's Library folders under `/Users/<username>/Library/Audio/Plug-Ins`.

To uninstall the plug-ins from your Mac, you can just delete the specific FabFilter plug-in files at the above locations. Finally, if you really want to delete all data written by our plug-ins, you can remove the following folders/files from the user Library folder as well:

- `/Users/<username>/Library/Audio/Presets/FabFilter/FabFilter Timeless 2`
- `/Users/<username>/Library/Application Support/FabFilter/Timeless 2`
- `/Users/<username>/Library/Preferences/com.fabfilter.Timeless.2.plist`

Note: Since OS X 10.7 (Lion), the system and user Library folders are marked as hidden by default. To make them visible again in Finder, open Terminal (found in `/Applications/Utilities`) and enter the following commands:

```
chflags nohidden /Library
chflags nohidden ~/.Library
```

If you still have problems, contact FabFilter Support.

Next: VST plug-in versions

See Also
Quick start
Support
VST plug-in versions

FabFilter Timeless 2 is available in both VST 2 and VST 3 formats. They can be installed and used both at the same time. The VST 3 format offers easy side-chaining and is more CPU-friendly in some cases, but it can only be used by hosts that support it, for example recent versions of Cubase, Studio One or FL Studio. The VST 2 format is compatible with a larger variety of hosts.

For the VST 2 format, there are two versions of the FabFilter Timeless 2 plug-in, one with and one without external side chain input:

- FabFilter Timeless 2 (stereo without side chain)
- FabFilter Timeless 2 (SC) (stereo with side chain)

The default VST plug-in does not have external side chain support because some hosts (e.g. older versions of Steinberg WaveLab) will not work correctly otherwise.

The external side chain feature in FabFilter Timeless 2 (SC) works well in some hosts, like Ableton Live and Reaper.

With Steinberg Cubase, it is recommended to use the VST 3 plug-in. With the VST 2 plug-in, you need to do the following to use an external side chain input:

1. Create a Group Channel track with Quadro configuration (in the More... menu).
2. Open the VST Connections window. In the Group/FX tab, locate the group bus you just created and right-click it to create child buses for the Stereo and Stereo (Ls Rs) parts.
3. In the Mixer, insert FabFilter Timeless 2 (SC) in the group channel track.
4. You can now route the input audio signal track to the Stereo child bus. The side chain track must be routed to the Stereo (Ls Rs) child bus. (The routing settings are found at the top of each channel.)
5. Use Timeless 2’s monitoring feature in the bottom bar to confirm that everything is routed as you want it.

Note: In earlier versions of Cubase, the Group/FX tab is missing from the VST Connections window. In this case, you must pan the input track to the front of the quadro bus, and the side chain track to the rear of the quadro bus.
External side chaining

FabFilter Timeless 2 offers the possibility of feeding an external signal to its side chain, so that you can make it trigger on a different signal than the audio it is actually processing. Feeding a signal to a plug-in's side-chain inputs works slightly different in various hosts. This topic describes the procedure for some of the most popular hosts around: **Pro Tools**, **Studio One**, **Ableton Live**, **Logic Pro** and **Cubase**.

To explain how it works, we use a scenario with two tracks. The first one contains the audio that we want to process with Timeless 2, which we'll call the **main track** from now. The second track contains the audio that we want to route to Timeless 2's external side-chain input and use as trigger signal. We'll call this track the **side chain track**.

After setting up everything according to the instructions below for your host, any **envelope generators** or **envelope followers** that are set to trigger on the external side chain, will now respond to the side chain signal. You can check whether everything is routed correctly: play the audio, open an EG or EF interface and confirm it's set to trigger to the external side-chain. Then use the Audition button to listen to the side-chain signal.

**Pro Tools**

- Open Pro Tools and start a new empty session.
- Create two audio tracks that we'll use as main track and side chain track. Add audio files to both track.
- Open the Mix window to display the tracks with their Insert slots and Sends slots.
- In the first 'Sends' slot of the side chain track, choose 'Bus 1'. The track view for Bus 1 will open: set its level slider to 0.0 dB so the bus actually produces audio!
- In the first 'Inserts' slot of the main track, choose Delay > FabFilter Timeless 2.
- Open Timeless 2's interface and set up an envelope generator or envelope follower, triggered by the external side chain signal.
- Now, in the 'Key Input' menu of the plug-in interface (just above the FabFilter logo), choose bus > Bus 1 instead of the default 'no key input'. Now, the audio from the side chain track is routed to Timeless 2's external side chain input via Bus 1.

**Studio One**

- Open Studio One and choose 'Create a new song'.
- Add two audio tracks (via Track > Add Tracks...) that we'll use as main track and side chain track.
- Add audio files on both the main track and the side chain track. You can simply drag audio files from a Finder/Explorer window onto a track.
- Access the mix window via "Mix" in Studio One's bottom right corner.
- Insert FabFilter Timeless 2 on your main track via the '+ button next to the Insert tab.
- Open Timeless 2's interface and set up an envelope generator or envelope follower, triggered by the external side chain signal.
- On the side chain track, select Sends > Sidechains > FabFilter Timeless 2.

**Ableton Live**

- Open Ableton Live and start with an empty arrangement. We'll use Track 1 as the side chain track and Track 2 as the main track.
- From the folder menu's on at the left top of Ableton Live's interface, drag different audio clips to the first empty slots of Track 1 and Track 2.
- From the VST (or Audio Units) plug-in menu, also at the left top of Ableton Live's interface, drag FabFilter Timeless 2 onto Track 2, the main track.
- In the small device interface for Timeless 2 in the bottom Effects section, choose 'Track 1' from the 'Sidechain' drop down menu.
- Open Timeless 2's interface and set up an envelope generator or envelope follower, triggered by the external side chain signal.
- **Note**: In earlier versions of Ableton Live (< 10.1), setting up sidechaining worked differently, which is described [here](#).

**Logic Pro**

- Open Logic Pro and create a new empty project via File > New...
- Add two audio tracks (via Track > New...) that we'll use as main track and side chain track.
Add audio files on both the main track and the side chain track. You can simply drag audio files from a Finder/Explorer window onto a track.

Select the main track and add Timeless 2 in the first Insert effect slot.

Open Timeless 2’s interface and set up an envelope generator or envelope follower, triggered by the external side chain signal.

In the right top corner of the plug-in interface header, in the 'Side Chain' menu, choose the side chain track. Now, the signal from the side chain track is sent to FabFilter Timeless 2's external side-chain input.

**Cubase**

Open Cubase and create a new empty project.

Add two audio tracks that we’ll use as main track and side chain track.

Add audio files on both the main track and the side chain track. You can simply drag audio files from a Finder/Explorer window onto a track.

Open the Mixer. In the main track, click on an empty insert slot and select the VST 3 version of FabFilter Timeless 2 in the Delay menu (note the VST 3 icon which looks like ///).

Open Timeless 2’s interface and set up an envelope generator or envelope follower, triggered by the external side chain signal.

In the plug-in header, click on the Activate Side-Chain button (right of the R/W buttons) to enable the external side chain in Cubase.

At the top of the Mixer, set the output for the side chain track to the side-chain input of FabFilter Timeless 2.

---

**Next:** Component routing

**See Also**

Input/output controls
Component routing

Next: License agreement

See Also
MIDI learn
Support
FabFilter Software License Agreement

This license agreement concerns and describes your rights and the conditions upon which you may use the FabFilter software you selected. We advise you to read this entire agreement. By accepting this agreement or by using FabFilter software, you agree to all of these terms. If you do not accept and comply with these terms, you may not use the FabFilter software or its features.

Applicability

This license agreement applies to all the FabFilter software, plug-ins and programs you may use during the Evaluation period, and/or thereafter subject to an acquired license key to certain FabFilter software of any version, including any and all upgrades, supplements or services, unless other terms come with such versions, upgrades or supplements.

Licenses

The software will be licensed to the Customer, not sold. With the FabFilter license key, you will be granted after full payment the right in perpetuity (meaning that the license agreement shall not automatically expire) to install, run and use the software concerned under certain conditions. These conditions vary subject to the license you acquired. FabFilter distinguishes the following licenses:

- A **Personal License** is a named license to the software concerned, granting access to the software on an unlimited number of Devices, as long the license is used by the designated person who acquired the FabFilter license key. Usage of the Personal license by someone else but the designated licensee is an infringement of the rights of FabFilter. The Customer should at all times protect its license key from theft and/or abuse.

- A **Site License** is a non-personal license to the FabFilter software concerned, acquired on the name of an institution or entity, who is the licensee. A Site License will grant access to the FabFilter software on a certain maximum number of designated Devices, as specified in the license key itself (e.g. "20 seats"). If the Site License is used on computers/servers for any form of automated processing, the licensee may not make any plug-in controls/parameters of the FabFilter software available to the end users of the FabFilter software, i.e. only "black box" processing is allowed.

These FabFilter licenses, whether a Personal or Site License, will give you access to certain FabFilter software of the specified major version. The license will include all future minor updates to the software (e.g. version 2.19 to version 2.20), which typically include bug fixes or small new features. The license will exclude any future new major versions of the products (e.g. version 1.x to version 2.x). To allow yourself access to such new major version of the software, a new FabFilter license to such major version must be acquired.

All FabFilter licenses, both Personal or Site License, give the Customer or end user the right to install and use the FabFilter software to the extent it has been developed and under the conditions herein. Any rights not explicitly granted to you, the Customer, remain with FabFilter, including but not limited to the right to alter, reverse engineer, reverse compile, take apart, or disassemble the FabFilter software or any of the files in the distribution.

A Bundle License is Personal or Site License for multiple FabFilter software products, which gives the Customer or end user the right to install and use the specific software products that the bundle (e.g. Total Bundle) contains at the moment of purchasing the Bundle License. Any software products or new major software versions added to the bundle after that date cannot be claimed as part of the prior acquired Bundle License. A Bundle License (if not Educational or NFR) can only be transferred as a whole, using a License Transfer.

An Upgrade License is a Personal or Site License for a new major version of FabFilter software. You may only use an Upgrade License if you have a license for the previous major version of the same FabFilter software.

**Educational (EDU) and NFR licenses**

A Personal or Site License can be marked as EDU (Educational) or NFR (Not For Resale), meaning the following:

- A Personal or Site License marked as Educational License is equal to the respective Personal or Site License, with the only exception that the Educational License may not be transferred to a third party.

- A Personal or Site License marked as NFR ("Not For Resale"), is typically intended for journalists that wish to review the FabFilter software. A License marked as NFR is equal to the respective Personal or Site License, with the only exception that the NFR License may not be transferred to a third party.

**Duration and Evaluation**

As specified in the specific terms per license, all licenses will be granted for perpetuity (meaning that the license agreement shall not automatically expire), as long as all conditions herein are respected.
The Evaluation period is a period of thirty (30) days commencing on the first day of using the software concerned and automatically expiring 30 days thereafter. After the Evaluation period has expired and no FabFilter license key has been acquired, the software will stop working and should be removed from your computer.

In addition to any and all such possibilities that FabFilter may have in accordance with the law, FabFilter may terminate without prior notice or warning in case of abuse of the FabFilter software as well as in case of (personal) bankruptcy.

Support
FabFilter shall give its reasonable commercial efforts to service any major version of any FabFilter software including email support. FabFilter is entitled to terminate support for any major version of any FabFilter software at any time at its sole discretion.

License Transfer
A Personal or Site License (not Educational or NFR) may be transferred to a third party. You will have to buy a License Transfer to activate the "transfer"-option in your FabFilter account. After this option has been activated you will be able to transfer your license to any third party.

Third Party Software
VST is a trademark of Steinberg Media Technologies GmbH. RTAS and AAX are trademarks of Avid Technology, inc. Audio Units is a trademark of Apple Computer, inc.

Applicable Law
This license agreement is governed by Dutch law. The courts of Amsterdam are authorized courts to rule on any dispute that may arise from this license agreement.

Disclaimer
TO THE MAXIMUM EXTENT PERMITTED BY LAW, FABFILTER, FREDERIK SLIJKERMAN AND FLORIS KLINKERT, AUTHORS OF THIS FABFILTER PRODUCT, SPECIFICALLY DISCLAIM ALL WARRANTIES, EXPRESSED OR IMPLIED, INCLUDING BUT NOT LIMITED TO IMPLIED WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. FABFILTER, FREDERIK SLIJKERMAN AND FLORIS KLINKERT, DO NOT WARRANT THAT THE SOFTWARE WILL MEET YOUR REQUIREMENTS OR THAT THE SOFTWARE WILL OPERATE ERROR-FREE OR UNINTERRUPTED. TO THE MAXIMUM EXTENT PERMITTED BY LAW, FABFILTER, FREDERIK SLIJKERMAN AND FLORIS KLINKERT, SHALL NOT BE LIABLE FOR ANY DAMAGE A FABFILTER PRODUCT MAY CAUSE OR DAMAGES THAT MAY ARISE OUT OF THE USE OF A FABFILTER PRODUCT OR INABILITY TO USE A FABFILTER PRODUCT, INCLUDING BUT NOT LIMITED TO SPECIAL, INCIDENTAL, CONSEQUENTIAL OR OTHER DAMAGES. IN NO EVENT FABFILTER, FREDERIK SLIJKERMAN OR FLORIS KLINKERT WILL BE LIABLE FOR AN AMOUNT IN EXCESS OF TWO HUNDRED FIFTY EUROS (€ 250,00).

Next: Acknowledgements
See Also
Purchase FabFilter Timeless
Support
Acknowledgements

Credits go to Gijs van Klooster for writing the initial version of this help file. You can visit Gijs' web site at www.redhouse.nl.

FabFilter Timeless 2 comes with a large library of presets. Almost all of these were created by external sound designers:

- bManic (BM)
- Rory Dow (RD)
- Thomas Koot (TK)
- Bryan "Xenos" Lee (XS)
- Daniel Maurer (DJM)
- Stephan Müsch (SM)
- Jaime Newman (JN)
- Ouroboros (O)
- Teksonic (TEK)

Visit the FabFilter sound designers page to read more about each sound designer.

Next: About FabFilter

See Also
Purchase FabFilter Timeless 2
Support
About FabFilter

Beautiful sound. Fantastic workflow. These are the foundations of FabFilter. We create powerful audio plug-ins with superb sound quality and innovative interfaces.

A unique perspective

At FabFilter, we make the best possible tools for music production and audio processing. To achieve this, we continually rethink and challenge industry standards: we've never been afraid of reinventing the wheel. Considering every little detail, we tune our algorithms and interfaces until they sound perfect, look amazing and feel great to work with.

It's the sound that counts

Above everything else, you need superb sound quality. That's why we put a lot of effort into developing unique audio processing algorithms, ranging from our famous resonating filters to transparent high-end EQ and dynamics processing.

Innovative interfaces, great design

Every FabFilter plug-in has an easy-to-use, well-designed interface aimed at providing unsurpassed workflow. Our plug-ins focus on the task you're performing at that specific moment: they expose the features you need, when you need them. And because of our special attention to design, you'll be delighted every time you open a FabFilter plug-in.

Don't take our word for it

We always set the highest standard for sound quality, usability and design to make truly great products that raise the bar on what audio software can do. That's why we're very happy with the praise we've received from users and press alike:

"In the decade since the release of its first plug-in, One, FabFilter has made an indelible mark on the music production landscape." — Computer Music magazine

"While many other software developers are busy trying to model hardware, FabFilter is leaving them in the dust by being visionaries and reaching into the future. FabFilter stuff is just on another level." — Jeff Sanders

"FabFilter has an enviable reputation for making easy-to-use, powerful tools." — Music Tech magazine

FabFilter was founded in 2002 by Frederik Slijkerman and Floris Klinkert, and is based in Amsterdam, The Netherlands.